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Introduction

Digital Synsations Volume 1
Four ’90s wonders revisited

Dive Into The ‘90s With a Modern Vibe
Explore the legendary sound of the ‘90s with 4 instruments inspired by some 
of the most famous digital synths of the time. With more than 600 presets, 
Digital Synsations Vol.1 delivers a massive collection of stirring sounds with 
distinct but familiar character. Explore the instruments that defined a decade 
of popular music, with new and classic sounds perfect for music of any style, 
from synthwave to modern production and beyond.

Synthesizer History
In the late ‘80s and early ‘90s the synthesizer landscape began to change. A 
new kind of keyboard began appearing; trading wood for plastic, familiar knob 
arrays for uniform clusters of buttons and glowing screens. They signaled 
more than a shift in how we interact with our musical counterparts‚ they 
ushered in the era of the digital synth. In addition to the benefits of digital 
processing, some of these keyboards also delivered innovative synthesis 
techniques, combining sample playback with classic methods allowing users 
the opportunity to explore new sonic territory.

Four classics, massive library
The possibilities with a few of these classics was more than we could bear and 
became the inspiration for Digital Synsations. We took 4 classic keyboards 
from the era and set our sound designers loose, tasking them to return with 
boundary-pushing sounds‚ and they did. Digital Synsations includes over 600 
patches expertly programmed on fully restored hardware‚ used by many of 
the greats including Depeche Mode, The Cure, Pet Shop Boys, Vangelis, Brian 
Eno, Toto, 808 State, Jean Michel Jarre and more.

Pristine Sound, Deeply Editable
All patches were deeply multisampled and edited to perfection before sending 
them off for professional mastering. These sounds became the foundation 
of Digital Synsations, and combined with the UVI Engine give you the true 
hardware character of these classic synths with all of the peculiarities and 
programming byproducts intact. Not only that, but you get them in an 
extremely easy-to-use and fast-to-edit environment complete with our 
advanced arpeggiator - use it to create epic progressions, or even automatic 
key-sensitive voicings..

-  4 unique instruments
-  600 tailored presets
-  Advanced arpeggiator

If you’re looking for a new take on the classic ‘90s sound, look no further.

Minimum System Requirements

• Latest version of UVI Workstation or Falcon

• 14.99GB of disk space

For more information on the installation process, please refer to the 

document: Soundbank Installation Guide

http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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DS1 - Main

2Amplitude

6Stereo

5Drive

3 Filter

4 Pitch

10 Arp

7 Bit Crusher

8 Effects

9 Modwheel

1 Mono / Poly

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp
» Vel > Atk

Remaps Attack to Note Velocity
» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter
» VEL

Adjust the filter velocity sensitivity
» CUT

Filter cutoff frequency
» RES

Filter resonance amount
» ENV

Depth of the filter envelope
» Filter Type

Multimode filter can be set to low-pass 
(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento
» Time

Sets the glide time

5  Drive
» Power
 Enable/Disable the Drive effect
» Amount

Switch between mono and poly voicing

6  Stereo
» Mode - Off  (mono)
» Mode - Alt

Stereo position alternates L/R every 
note, width controlled by [Width]

» Mode - Uni
Layers multiple samples and augments 
them for increased stereo presence

» Color
Utilizes neighboring samples from the 
library to a unique effect

» Width
Sets the stereo width (ALT mode)

» Tune
Detunes the unison layers (UNI mode)

7  Bit Crusher
» Power
 Enable/Disable the Bit Crusher effect
» Bit
 Set the bit reduction
» Frequency
 Set the Bit Crusher sample rate
» Drive
 Adjust the overdrive amount of the 
 Bit Crusher effect

8  Effects
» On/Off Switch

Enable/Disable the effects; Phaser, Delay 
and Reverb

» Mix
Adjust effect mix amount

9  Modwheel
» On/Off Switch, Amount

Easily route your controllers Modwheel 
to control common parameters such as 
Vibrato, Tremolo and Filter Depth

10  Arp
» On/Off Switch
» Edit

Oppen the Arp Edit window
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1  Arpeggiator
 Click ARP to select the Arpeggiator

» Mode - Click to set the arpeggiator 

mode: Arpeggiator, or Phraser

» Octave Low/High - Lock the sequence 

in a specific octave range, with lowest 

and highest octave [Phraser mode only]

» Motion - Click to set the arpeggiator 

motion as played, up, down, or up+down 

[Arp mode only]

» Speed -  Set the step duration

» Steps - Set the number of steps

» Octave -  Set the octave range of the 

arpeggiation

2  Preset
» Preset - Change presets by drop-down 

menu or by using the ◀▶ arrows

3  Chord Detector
» Chord - Indicates the chord type 

detected from current incoming MIDI 

notes

4  Shift
» Shift - Move all sequence steps left or 

right

5  Step Editor
» Velocity - Click-drag to set the velocity

» Link - Enable to sustain the previous 

step

» Mode - Set the step type (Basic, 

Harmonized or Chord) based on mode

» Pitch - Set a pitch offset in semitones

» Octave - Set a pitch offset in octaves

» Gate - Set the step gate duration

» Pan - Set the step pan

» Menus  - Click the ▼ button to right 

side of each row to either initialize, 

randomize, or select a preset. 

6  Close
 Click X to close the Arp page

1Arpeggiator

DS1 - Arp

Step Editor5

Chord Detector3

Shift4

Close6

Preset2
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DS1 - Preset List

00 Custom Iconics

EPiano

Magic Organ

Nimbus

Ooh Ahh

Organ

Piano 16

Pick Bass

Slap Bass

Universe

Vibes

Arp and Seq

Acid Brass 1K

Acid Clav

Aliens

Big Choir

Bow Wheel

Choir Chords

Classified 1K

Distant Pad Wheel

Dream Road 1K

Far Away

Filter Synth

Flute Chords

Flute Stabs

Frich

Kalimba Motion

Octave Glitch

Shadows 1K

Simple Choir

Spaceship 1K

Speedwave

Squalala

Sweat Dreams

Training 1K

Twisty Roads

UFO

Bass

Clav Dirty Bass

Crunch Power

Digital Fake

Duran X 2

Gritty Bass

Marcus Thumb

Muted B

My Double Bass

Pastorius Land

Synth Slap

Bells

Bell Air

Christmasonic

Church Bells

Mirah Bell

Orchestral Bells

Organ Bells

Ring My Bell

Sky Bells

Space Xylobell

Fretted

Dirty Clean

Double Guitar

Electric Steel

Garage Band

Harmodreams

Nylon Digital

Strato Crunch

The Fret and The Beauty

Keys

Digital Clav

DraculorgAn

Dream Electric

Fast Tremolo EP

FM Dyno

Hybrid Keys

Modern Doors

Mythical M Organ

Mythical M Piano

Nineties Stack

Perky Organ

Power Piano

SG Road

Soft Airy Church

SpaCelesta

Misc.

Electro Pop Corn

Ethnic Roll

Find the Mistake

FX Wheel Me 1

FX Wheel Me 2

Indian Steel Drums

Long Evolution

Mayhem of Loops

Mini Balafon

Multi Percs 1

Multi Percs 2

Multi Percs 3

One Thing

Perky Fluty

Peruvian Flavours

Run Mandolin

Short Wood

Tajma Hall

Water Loop

Orchestral

Baroque Harpsi

Digital Requiem

Ensemble Arco

Flute Ensemble

Full Horn Section

Large Choir 1

Large Choir 2

Open Orchestra

OrCELTICestra

Philharmonia

Pop Brass

So Emotional

Soft Buggle

Space Oboe 

TubulOrchestra

Pads

Bell Ominous

Chocolate Factory

Dream On

Hybrid Deep

Majesty

Moving Cycle

My Choirs

Nineties Pad

Paddy Fluty

Porta Chording

Porta Voices

Slow Stack

Space Requiem

Super Air

Ultra Slow

Vox Planet 1

Vox Planet 2

Wheel Me Tender

Zenithsphere

Synth Poly

Digital Fretted

DupStep Vox

Harsh Digital String

Pana Dubstep

Poly Brassy

Poly Vox

The Funky Poly

Synth Solo

Blow Lead

Echo Land

Funny Lead

Glassy Fluty

Phasio Lead

Solo Crunch

That Flute

The Funky Solo

Tight Synth

Typical House Sax
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DS77 - Main

2Amplitude

4Pitch

5Drive

1 Mono / Poly

3 Filter

7 Bit Crusher

8 Effects

9 ModWheel

10 Arp

6 Stereo

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp
» Vel > Atk

Remaps Attack to Note Velocity
» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter
» VEL

Adjust the filter velocity sensitivity
» CUT

Filter cutoff frequency
» RES

Filter resonance amount
» ENV

Depth of the filter envelope
» Filter Type

Multimode filter can be set to low-pass 
(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento
» Time

Sets the glide time

5  Drive
» Power
 Enable/Disable the Drive effect
» Amount

Switch between mono and poly voicing

6  Stereo
» Mode - Off  (mono)
» Mode - Alt

Stereo position alternates L/R every 
note, width controlled by [Width]

» Mode - Uni
Layers multiple samples and augments 
them for increased stereo presence

» Color
Utilizes neighboring samples from the 
library to a unique effect

» Width
Sets the stereo width (ALT mode)

» Tune
Detunes the unison layers (UNI mode)

7  Bit Crusher
» Power
 Enable/Disable the Bit Crusher effect
» Bit
 Set the bit reduction
» Frequency
 Set the Bit Crusher sample rate
» Drive
 Adjust the overdrive amount of the 
 Bit Crusher effect

8  Effects
» On/Off Switch

Enable/Disable the effects; Phaser, Delay 
and Reverb

» Mix
Adjust effect mix amount

9  Modwheel
» On/Off Switch, Amount

Easily route your controllers Modwheel 
to control common parameters such as 
Vibrato, Tremolo and Filter Depth

10  Arp
» On/Off Switch
» Edit

Oppen the Arp Edit window
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1  Arpeggiator
 Click ARP to select the Arpeggiator

» Mode - Click to set the arpeggiator 

mode: Arpeggiator, or Phraser

» Octave Low/High - Lock the sequence 

in a specific octave range, with lowest 

and highest octave [Phraser mode only]

» Motion - Click to set the arpeggiator 

motion as played, up, down, or up+down 

[Arp mode only]

» Speed -  Set the step duration

» Steps - Set the number of steps

» Octave -  Set the octave range of the 

arpeggiation

2  Preset
» Preset - Change presets by drop-down 

menu or by using the ◀▶ arrows

3  Chord Detector
» Chord - Indicates the chord type 

detected from current incoming MIDI 

notes

4  Shift
» Shift - Move all sequence steps left or 

right

5  Step Editor
» Velocity - Click-drag to set the velocity

» Link - Enable to sustain the previous 

step

» Mode - Set the step type (Basic, 

Harmonized or Chord) based on mode

» Pitch - Set a pitch offset in semitones

» Octave - Set a pitch offset in octaves

» Gate - Set the step gate duration

» Pan - Set the step pan

» Menus  - Click the ▼ button to right 

side of each row to either initialize, 

randomize, or select a preset. 

6  Close
 Click X to switch back main page

1Arpeggiator

DS77 - Arp

Step Editor5

Chord Detector3

Shift4

Close6

Preset2
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DS77 - Preset List

00 Custom Iconics

Big Brass

Discovery

EP Dyno

FM Synth Bass

Funky FM

Harmonix

Mix Brass Choir

Mix Choir Brass

Piano 8

SY Fairlight

Arp and Seq

Angry Acid 1K

BeautHybrid

Challenger

Chamois

Chord Stabs

Dirty Choir

Epic Choir

Fast Arp

Liquid Vocal

Minor Chimes

Odd Chords

Old Arp

Police Chase 1K

Rumble Car 1K

Rythmic Lead 1K

Sarod Sequence

Shuttle

Simple Whistle

Space Runner

Spaceship

Strange Guitare

Ultra Saw

Vocal Echo

Voice Over

Wheel Wonkers

Bass

Big Modwheel Me

ClaviBass

Da Synth

Double Bass

Electric Bass

FM Square Bass

Nasty Talk

Organic

Pure Nineties

Trash Bass

Bells

BeautHybrid

Digital Like

Dyno Bells

Easter Bells

Happy Rotter

Larsenic

Little Portam

MadBell Men

Massy Christmas

Musical Box

Round Golden

Sponsor Bells

Voicy Bell

Whole F Bell

Keys

Digital Clav

Digital Organ

DS Pure Tines

Electronic Dyno

Extrem Dyno

FM Clavinet

Grand One

Hamm Organ

Large Electric

Large Spatial Road

My Dream

New Age EP

Phasynet

Pure Digital Keys

Real Clav

RnB Road

Soft Church

Space Toy Piano

Vocal EP

Yanni Keys

Leads

Dirty Brassy

Dirty Poly

FM Lead

Happy Whistle

Hybridation

Kitch Sax Lead

Milka Lead

Scream X

Soliclave

Synth SolHorn 

Misc.

Balaphonic

Disto Stack

Dreamology

Ethnic Pluck

FM Sarod

Fretted Synth

Fx Horlogery

Hesitation

Indian Flavour

Japamisen

Steel Electric Drum

Stratospheric

Synth Guitar

Vibraphone

Orchestral

French Ensemble

Full Ensemble

Glass Brass

Little Symphony

Simple Harp

Slowrchestra

Space Horns

Tutti Slowness

VibrOrchestra

Pads

Black Mont Blanc

DigOminous

Glossy Pad

Just Who Fly

Machine Strings

Magic Strings

Mellocoton

Motionesk

OMetal Pad

Pad on Five

Paradigm

Polaire

Slow Emotion

Smooth French

Solinox

SweePad

Ultra Dirty

Polysynth

Bronsky Poly

Cindy Bridge

Funky Mama

Ninth Dimension

Pluckmania 1

Pluckmania 2

Poly Keys

Raw Poly 1

Raw Poly 2

So Yummy Brass

Soft Digital Native

Synth Brass

Vocalized

Art of Voice

Choirizo

Ethereal Killer

Faith and Choir 1

Faith and Choir 2

Gladiators

Hummanoid

Hybrid Vocal

Lady GaVox

Massivocal

Planet Vox

Portachoir

Vocal Glass
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DS90S - Main

2Amplitude

6Stereo

1Mono / Poly

5Drive

3 Filter

4 Pitch

10 Arp

7 Bit Crusher

8 Effects

9 ModWheel

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp
» Vel > Atk

Remaps Attack to Note Velocity
» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter
» VEL

Adjust the filter velocity sensitivity
» CUT

Filter cutoff frequency
» RES

Filter resonance amount
» ENV

Depth of the filter envelope
» Filter Type

Multimode filter can be set to low-pass 
(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento
» Time

Sets the glide time

5  Drive
» Power
 Enable/Disable the Drive effect
» Amount

Switch between mono and poly voicing

6  Stereo
» Mode - Off  (mono)
» Mode - Alt

Stereo position alternates L/R every 
note, width controlled by [Width]

» Mode - Uni
Layers multiple samples and augments 
them for increased stereo presence

» Color
Utilizes neighboring samples from the 
library to a unique effect

» Width
Sets the stereo width (ALT mode)

» Tune
Detunes the unison layers (UNI mode)

7  Bit Crusher
» Power
 Enable/Disable the Bit Crusher effect
» Bit
 Set the bit reduction
» Frequency
 Set the Bit Crusher sample rate
» Drive
 Adjust the overdrive amount of the 
 Bit Crusher effect

8  Effects
» On/Off Switch

Enable/Disable the effects; Phaser, Delay 
and Reverb

» Mix
Adjust effect mix amount

9  Modwheel
» On/Off Switch, Amount

Easily route your controllers Modwheel 
to control common parameters such as 
Vibrato, Tremolo and Filter Depth

10  Arp
» On/Off Switch
» Edit

Oppen the Arp Edit window
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1  Arpeggiator
 Click ARP to select the Arpeggiator

» Mode - Click to set the arpeggiator 

mode: Arpeggiator, or Phraser

» Octave Low/High - Lock the sequence 

in a specific octave range, with lowest 

and highest octave [Phraser mode only]

» Motion - Click to set the arpeggiator 

motion as played, up, down, or up+down 

[Arp mode only]

» Speed -  Set the step duration

» Steps - Set the number of steps

» Octave -  Set the octave range of the 

arpeggiation

2  Preset
» Preset - Change presets by drop-down 

menu or by using the ◀▶ arrows

3  Chord Detector
» Chord - Indicates the chord type 

detected from current incoming MIDI 

notes

4  Shift
» Shift - Move all sequence steps left or 

right

5  Step Editor
» Velocity - Click-drag to set the velocity

» Link - Enable to sustain the previous 

step

» Mode - Set the step type (Basic, 

Harmonized or Chord) based on mode

» Pitch - Set a pitch offset in semitones

» Octave - Set a pitch offset in octaves

» Gate - Set the step gate duration

» Pan - Set the step pan

» Menus  - Click the ▼ button to right 

side of each row to either initialize, 

randomize, or select a preset. 

6  Close
 Click X to switch back main page

1Arpeggiator

DS90S - Arp

Step Editor5

Chord Detector3

Shift4

Close6

Preset2
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DS90S - Preset List

00 Custom Iconics

Digital Nation

DS Choirs

Fantasy Bells

Ice Choir

NarcOrchestra

Overthinking

Pizza Yolo

Score Five

Stacc Paradise

Yes Voices

Arp and Seq

Amplitube

Analogish 1K

BeeBounce

Broken Piano

Chirpy 1K

Digital Nostalgia

Dreamy

Fairy

Fantastic Tales

Lake Goddess

Mystery Cave 1K

Nature Liech

Night Car

Night City 1K

Poetic Bird

RapidFire

Rebound

Rider 1K

Space Emulsion

Starting Block 1K

Techno SAV

Untold Story

Up Stairs 1K

Water Drama

Well

Bass

Analogish

Big Bass

Digital Harp JMJ

DigiTaurus

DS90s Wave Bass

Dual Slappy

FM Bass

Funk Analog B

Hard Drone

Huge Analog B

Hummer Digital

Hybrid Synth Bass

Imagination Bass

Mega Square

My Crazy B

Nineties Dubstep

Omni Bass

Pure Synth Bass

Reggaetonix

Road F Bass

Seq Glassy Bass

Space Slap

Tangerine Delay

Thumb Number

Ultra Bass

Vancouver Bass

Very Low Rkestra

Bells

Digital Box

Dream Bells

Fifth Dimension

Glass and Pad

Harpsybell

Iconic Bells

Kalimbell

Light Bells

Mad Chinese

Majestic Chimes

Mike New Field

My Little Bell

Nineties Hi Bells

One Digital Bell

Organic D90s Bells

Position Bell

Pro Ana Bells

Robert Bells

Soft Dirty Bells

Space Carillon

Sure Thing

Synth Analog Bell

That Bell

Unique Random

Keys

Dark Synth Piano

Digital Keys

Dual Clav

Full Tines 90s

Hard Dyno

Karoussel Mania

Keys Cassie

Little Piano

Magic Church

My Paroisse

Nineties Funk

OrganX

Percussiv Organ

Romantic Keys

Screamosphere

Soft Dirty Organ

Soft Keytar

Space Upright

Space Wurly

Synth Seq Keys

Ultra Soft Keys

Leads

BrassOloing

Curtis Pan Flute

Funky Five

Hard Panned Flute

House Lead

Hybrid Solo Synth

Jairo Lead

Latino Flute

Nine Lead

Pure Soft

Scream Solo

Shakuashi

Shop Lead

Shorty Slog

Solead Six

The Bee StooFly

Ultra Soft Solo Pad

Zebra Clinton

Pad - Choir

BBW Pad

Fair Synsations

Fairosphere

Flute Landscape

Glassy Glossy

La Chapelle

Mellow Choir

Moldavia

Monastere

Multi Flavored

My Padroisse

Ominalog

Pad in Box

Power Pad

Shaku Pad

Smooth and Dark

Space Choir

Sparkle D Pad

Synth Glass Vox

Tron Choir

Wheel to High

Zodiac Pad Bells

Polysynth

Hook Factory

Mallet Planet

Neat Analog

Obese Poly

Pol Crazy

Poly Metal

Power Synth

Scream Brass

Serious Synth

Short One

Skrillexed

Softy Poly

Standard Synth

Vangelis Feel

Strings-Orchestra

Digital Opening

Dynamic Ensemble

Ethereal Orchestra

Expressive Strings

Fastrings Brassy

Full Section

Harp and Orchesta

JarrOrchestra One

JarrOrchestra Two

Marcascendo

My White

Ominous Digital

Rugged Strings

Section French

Slow Lee Wood

Solo Detache

String Machine

Stringanalog

Tutti Orchestra

Sweeps

Chama Low

Flower Power

Hybrid Sweep

Naturalia

Steady Sweepy

Sweep on Wheel

Sweepy Lopez

Synth Brass

Classic Analog

Fat Brass

Funky Fresh

Iconic Brass

Matrix Brass

Mellow Brass

Number One

OB Phatty

Party Hook

Porta Brass

Power Brass

Pure Synth Brass

Soft Brass Ensemble

Solid Brass

Stab Digital

Tower Power

White Horns
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DSX - Main

2Amplitude

6Stereo

5Drive

3 Filter

4 Pitch

1 Mono / Poly

10 Arp

7 Bit Crusher

8 Effects

9 ModWheel

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp
» Vel > Atk

Remaps Attack to Note Velocity
» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter
» VEL

Adjust the filter velocity sensitivity
» CUT

Filter cutoff frequency
» RES

Filter resonance amount
» ENV

Depth of the filter envelope
» Filter Type

Multimode filter can be set to low-pass 
(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento
» Time

Sets the glide time

5  Drive
» Power
 Enable/Disable the Drive effect
» Amount

Switch between mono and poly voicing

6  Stereo
» Mode - Off  (mono)
» Mode - Alt

Stereo position alternates L/R every 
note, width controlled by [Width]

» Mode - Uni
Layers multiple samples and augments 
them for increased stereo presence

» Color
Utilizes neighboring samples from the 
library to a unique effect

» Width
Sets the stereo width (ALT mode)

» Tune
Detunes the unison layers (UNI mode)

7  Bit Crusher
» Power
 Enable/Disable the Bit Crusher effect
» Bit
 Set the bit reduction
» Frequency
 Set the Bit Crusher sample rate
» Drive
 Adjust the overdrive amount of the 
 Bit Crusher effect

8  Effects
» On/Off Switch

Enable/Disable the effects; Phaser, Delay 
and Reverb

» Mix
Adjust effect mix amount

9  Modwheel
» On/Off Switch, Amount

Easily route your controllers Modwheel 
to control common parameters such as 
Vibrato, Tremolo and Filter Depth

10  Arp
» On/Off Switch
» Edit

Oppen the Arp Edit window
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1  Arpeggiator
 Click ARP to select the Arpeggiator

» Mode - Click to set the arpeggiator 

mode: Arpeggiator, or Phraser

» Octave Low/High - Lock the sequence 

in a specific octave range, with lowest 

and highest octave [Phraser mode only]

» Motion - Click to set the arpeggiator 

motion as played, up, down, or up+down 

[Arp mode only]

» Speed -  Set the step duration

» Steps - Set the number of steps

» Octave -  Set the octave range of the 

arpeggiation

2  Preset
» Preset - Change presets by drop-down 

menu or by using the ◀▶ arrows

3  Chord Detector
» Chord - Indicates the chord type 

detected from current incoming MIDI 

notes

4  Shift
» Shift - Move all sequence steps left or 

right

5  Step Editor
» Velocity - Click-drag to set the velocity

» Link - Enable to sustain the previous 

step

» Mode - Set the step type (Basic, 

Harmonized or Chord) based on mode

» Pitch - Set a pitch offset in semitones

» Octave - Set a pitch offset in octaves

» Gate - Set the step gate duration

» Pan - Set the step pan

» Menus  - Click the ▼ button to right 

side of each row to either initialize, 

randomize, or select a preset. 

6  Close
 Click X to switch back main page

1Arpeggiator

DSX - Arp

Step Editor5

Chord Detector3

Shift4

Close6

Preset2
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DSX - Preset List

00 Custom Iconics

Dynamit Bass

Elementary

Full Ensemble

Hybrid Guitar

Inspiration

Large Strings

Miami Keys

Piano Grand

Stack VFX

Synth Vibes

Arp and Seq

90sKeys Arp

Binary Groove 1K

Bruteforce 1K

Climax

Damaged Tape

Dancing Chimes

DisChord

Drifting In Space

Drunk Chords

Indochina 1K

Lemon Slice

Los Santos

ProdigyIsh 1k

Roll The Dice 1K

Shortstop Muted

Skyscrapers 1K

Souvenir Celesta

Space Steel

Swelling Chords

Toki Arcade

Tokyo Switch 1K

Trebleshooting 1K

Trenchtown

WarpedStrings

Weekend

Bass

Attackanalog

Digital Electric

Electric Pick

Mode Depeche Like

Move your B

Nineties Back

Pure Analog B

Slap Wha Wheel

So Analog

Square Bass

Transistoring

Bells - Mallet

Caribean Steel

Digital Sanzations

Digital SX Bells

Doors Bells

Little Celesta

M Balafon

Mallet Vibes

Mini Christmas

Smallet Box

Space Steel Drums

Synth Bells

Composite - Stack

Digital Native

Dream Piano Pad

Frets and Pads

Guitar Sine

Multi Layer Keys

Nineties Piano Strings

Space Guitar

Stackosphere

Strings and Horns

Electric Pianos

Composite Road

DSX Piano

DX Piano

Dynogital

Electric Synth Piano

Express Hybrid

FM Synsations

Hard Tines

Large Tines

Mixed Road Grand

Modeling TInes

Orlando Road

Tines after Time

Ultra Soft Road

Wurlysoniq

Leads

Analog Scream

Digital Square

High Solo

Hybrid Lead

MarimPan

Scie Musicale

Skrill Guitarex

Solo Synth Brass

Super Analog

Tutti Flutti

Misc. Keyboards

Baroque Harpsy

Clavi Planet

Concert Piano

Crunch Fast Organ

Digital Grand

Doors Maniac

Full Church

Full Drawbars

Grand One

Hybrid Piano

The Jaguar

Orchestral - Strings

Dark Orchestra

Dynamic Ensemble

Fair Orch Hit

Full Stacked

Large Strings

Marca Sean

Orchestral Timp

Power Strings

Soli Chamber

ZeBrass

Pad - Choir

Choirotron

Dark Portland

Deep Vox

Ever East

Hyper Majestic

Jack Mountain

MagiChorale

Mellow Cotton

Moving Pad

Padamento

Quaduo Bed

Space Choir 1

Space Choir 2

Very Fair X

War of Pads

Polysynth-Brass

A Classic Brass

Digipolis

Eighties Pop Brass

Fat Synth Brass

Full Brass

Funky Digi Brass

Poly Snipper

That Polysynth
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Links

UVI

Home                                                                                     uvi net/ 

UVI Portal                                                                                 uvi net/uvi-portal 

Soundbank Installation Guide                                                         installing_uvi_soundbanks_en pdf 

UVI Workstation User Guide                                                           uviworkstation_user_guide_en pdf 

Your Registered Product Serial Numbers and Download Links                  uvi net/my-products 

FAQ                                                                                       uvi net/faq 

Tutorial and Demo Videos                                                             youtube com/

Support                                                                                   uvi net/contact-support 

iLok

Home                                                                                     ilok com/ 

iLok License Manager                                                                  ilok com/ilm html 

FAQ                                                                                       ilok com/supportfaq 

http://www.uvi.net/
https://www.uvi.net/uvi-portal.html
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/#!license-manager
https://www.ilok.com/#!faq


Produced by UVI

Recording / Editing / Sound Design
Tanguy Destré
Alain J Etchart
Corentin Foldes
Théo Gallienne

Kévin Guilhaumou
Clément l’Hôte

Thomas Kowalski
Floriane Palmkrantz

Damien Vallet

Software + Scripting
Olivier Tristan
Remy Muller

GUI
Nathaniel Reeves

Documents
Nathaniel Reeves

Kai Tomita

Special Thanks
Chrisian Sales

Manu @ Masterwave for everything!
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